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NGSS PE for Global Climate Change — Middle
School

MS-E553-5. Ask questions to clarify evidence of the factors that
have caused the rise in global temperatures ovar the past century.
[Clarification Statement: Examples of factars include human activities
[such as fossil fuel combustian, cement progduction, end agricultural
activity) and natural processes {such as changes in incaraing salar
radiation or voleanic activity). Examples of evidence can include tahles,
graphs, and maps of global and regional temperatures, atmospheric
levels of gases such as carbon dioxide and methane, and the rates of
human actlvitfes. Emphasls is on the major role that hurman actjvities
play In causing the rise in global temperatures.]
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Designing a SE/NGSX aligned unit:

: e oy
i . W at Preat H
i Engage wava, diought, (ooding, polar WROX...), H
5 *  StaryRne: You are a msaarcher Bt  lactl Univarsity wititng a grant. |
; 1o sy s f ghbad i !

focal scanomy: H

; «  LakoMandsta lcoDates Graphing
; Explare Dancing Malostlas

* Explain o Phanamenay; Candls b 8 jar (SSX machling opporunity+ may
. a5 gl f Carban Cycls lsasons)

; v Garban Cycls Gamaand Medal {ombeddad assessment)

; Extend #  How Mugh Carban 15 In My Trea?

H * {magls 'Es)

Evaluate ® Lot Rosanch Quastien prejast (ambacdod assessmont)

Engage

* Begln with a local incldent of unusual climate (abnormally hot,
cold, rainy/floading, drought...)
* Discyss;
* What could cause this?
* |sthere a pattern?
o \What bl ions could we to h?
= Whatare the sttibutes of 2 testable questioa?
~ How do we evaluate research sources? {C.ARS, GER)
« How should we react?
» Adapt {fzrming, tetrlsm)
* Change behavior {energy generation)




Practice Evaluating Information

Provide groups of students with diffarent articles about focal effects
of climate chenge In your area.

Using C.A.R.5. checklist, have students evaluate reliability of the
source,

Using C.ER,, have students evaluate the content of the article.
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Explore: How do we know the climate is
changing? {Argue from Evidencgl
* One example: Lake l
Mendota, Madlsan, Wi

+ Records of fce coverage
{in days) from 1855 to
present
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Student Activity: Graph the lce Duration
Data (Math and Technology)

‘bitos:funewryoutybe comManehV=8dPAWITD 0] Lake Mendota les Dutvideo

. datasee ige cover

Explain: Greenhouse Effect - Dancing
Molecuies {Modeling)

+ hitps:/fwww.youtube.co
m/watchfv=AIBkD B
a ‘

+ Seott Denning, professor
&t Colorada State,

explains how greenhousa
gases dange.
« Dancing Molecsdles student

activity [created by Dr, Janst \ial,
Grand Vallgy StwaUnfeershy,
Michigan)

-

Explain: The Carbon Cycle (Develop Models)

+ Begin with Candla ina Jar

" phenomenon

* Use NGSX “tatk moves” to diseuss
student-generated models that
explaln what they've observed.

hitp:/flearndbir.org/ragources/4-
Goals_and Moves-Checklist.pdf
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Explain: Carbon Cycle.{More Models)
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Extend: Trees are
Carbon Sinks {Math)
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Carbon Cycle Model Embedded Assessment

{Modeling, Constructing Explanations)
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Evaluate: Getting to the grimary SEP (Asking
questions to clarify evidence)

» Students prepare a research grant proposal on the effects of climate
change eh a lacal industry or economy {sgriculture, tourlsm, etc.)
= Tha propesal must Include:
« Atastahle quastion
* Atleastthrea celizble research saurecs related to your question,
« Alogleal hypathesls
* An argumant for the hyaothetls using evidenee from the three sourees.

Skills involva using cheeklsts to evaluate eeliablllty af sources B €. E. R. formats to evatuate artlcla
eantent.

Engineering a Solution

“Scientists dream about doing great things.
Engineers do them.”

James A. Michner
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Disciplinary Core ideas
£aigs

Hiddio Schin! Englnaorieg Daslyn

By Ve Eliras Muharin revpcts MGLE0 Ao V1Y 4440kt T i) fo 0t et Kby i s
bt i TH QOB Tk wikioe. MELKIIRN ok L0460 Dot Aot
o i, ot B

Lhe
IR 15 LAY 8 D ey o i H

Girflning the prwklom wa Lhevndy o .

P seepier U tidre
ST Sl o 1 o 43 e T Bt o S
i I et b roath e e e Seeiet 11 st

SeaTARS oo ot ek i 233I0A30I o St THl] G TG B s
150 o G2ttt At U et [t ey T
G i Em’u.nm%&umuﬂ{m
TR, T ORI P ARR Y Bt 9 £ s b o

o S L BT 1] kbt S Tor e,
L TR 3T 1A ey 0 S5 P Aoy 11,
AL S

I M IO (ara i, EviAtith v,

Guvaitepiin et Besiut ks
m:w.mwwww”wmwmmum e, TP

a8 procaie o Vil sk
Buposdrby uwh wmu? mm&mawm—nﬁm’
et I, W Pt ol £ 153 iy g Lo €4 0 sy € Dt Gt A

Riorwes ek £ w16 4o 1 118 s

Frbrieciets it 45 18 10T0R tE3od Dl Wrndhecn b 3k Goeidemst bt A 1
ey st T s S S ety ol tieush St i
s (Ve L ro’

1117/2017

- Wind Turbines

* https:/fwww.youtuhe.co
m/watchfv=sXZkn2w-
I3

» Bittps:/fwww.youtube.co
m/watch?v=8IWTOdHEa
2g&featurszyoutu.be

Engineering Challenge

* Students hulld wind turbine madels to find the design that
rotates langest, using card stock, straws, and pins
* Recard work in Engineering Journal
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Your turnl
* Try out the Dancing Molecules
activity

* Play the Carbon Cycle game
* Design and test a “wind turbine”

This FowarPolntls avallahle on my gehoot
wabslie:
1, o n 50




Checklist

Goals for Productive Discussions and Nine Talk Moves

4. Time to Think

- Partner Talk

- Writing as Think Time
~Wait Time

Talk Science |

I ]2 say More: _
“Can you say more about that?*
"What do you mean by that?*
“Can you give an example?*

l:l 3. So, Are You Saying...?:
“So, let me see if I've got what you're saying. Are you saying.,.?"
(always leaving space for the original student to agree or disagree and say more) -

L—_I 4. \Who Can Rephrase or Repeat?
“Who can repeat what Javon just said or put it into their own words?”
(After a partner talk) “What did your partner say?”

5. Asking for Evidence or Reasoning
“Why do you think that?”
“What's your evidence?”
“How did you arrive at that conclusion?”

D 6. Challenge or Counterexample
“Does it always work that way?
“How does that idea square with Sonia’s example?”
“What if it had been a copper cube instéad?

D 7. Agree/Disagree and Why? . -
“Do you agree/disagree? (And why?)"
“What do people think about what lan said?”
“Does anyone want to raspond to that idea?”

8. Add On:
“Who can add onto the idea that Jamal is building?”
“Can anyone take that suggestion and push it a little further?”

9. Explaining What Someone Else Mesans
"Who can explain what Aisha means when she says that?”
“Who thinks they could explain why Simon came up with that answer?"
"Why do you think he said that?”

The Inquiry Prajecs: Bridging Research & Praciice
Supparted by e Mationsf Sdence Foundation Cg

Copyright 2012, TERC. All Rights Reserved.

7 Adapted rom: Chanin. 5. YCannar & 2. Andarcas K1 10000



Article 1- The C.A.R.S. Checklist fox Evaluating Internet Sources

Website Evaluation Checklist

Title of the website:

Credibility: A source that is created by a person or organization
who knows the subject and who cares about its quality.

Is there a publishing or sponsoring organization?

Does the individual or organization list all of their
qualifications, or credentials? Are they experts in their
field?

Does the website have an .edu, .org, or .gov ending in its
URL?

Yes

Accuracy: A source with information that is current, complete, and
correct.

Based on the reading you have already done on the
subject does the information on the site seem accurate?

Is the website free of spelling errors, grammatical
errors, dead links, or other problems that indicate lack of
quality control?

Reasonableness; a source that is truthful and unbiased

Does the website avoid advertising that may be in conilict
with the content of the website?

If an issue is covered, are both sides presented?

Do you trust the author or organization that has created the
website?

Support: A source with verifiable sources of information?
Is factual information referenced in footnotes or a
bibliography?




Article 1: Claims Evidence Reasoning

Title:

Source Citafion:

Quesiion:

Claim:
(The answer to the question.)

Evidence:
{List the scientific data that supports
the claim.)

%

Reasoning: _
(Explain how-the evidence supports
the claim.)




Created by Christine Geerer, Grosse Painte Public Schools

Lake Mendota lce Graph
Directions

1. Open Microsoft Excel.

2. In Row 1 Column A (top left box) type End Year.
3. In Row 1 Column B type Days of lce.

4. Fillin YOUR data set.

Example:
End Year Days of ice
1856 118
1857 151
1858 121
1859 96
1860 110

5. When you have all your years entered, highlight both columns from top to

bottom.
. Choose the Inseri tab at the fop of the page.

. Choose Scatter, Choose the scatter plot with sharp lines.

Click on Trendline.

B
7
8. Choose the Layout tab at the top of the page.
9
1

b. Choose Linear.

Your graph shouid look something like this:

Days of ice

=== Days of lce

——Linear (Days of ice)

1855

T

1860

1865 1870 1875

1

17



11. Click directly on the chart title. Change your title to Days of Ice on Lake
Mendota (fill in your years). Siretch the chart out if needed.

12. Using the Layout tab, choose Axis Titles. Choose Primary Horizontal Axis.
Choose Title Below Axis. Click on the text box on the chart. Type in Year.

13. Using the Layout tab, choose Axis Titles. Choose Primary Vertical Axis.
Choose Rotated Title. Click on the text box on the chart. Type Days of Ice.

Days of lce on Lake Mendota 1854-1870

160

M
Wl

=
fand
(=

=
Q
o

=)
o

==g==Days of lce

Days aof ice

o
o

——Linear {Days of Ice)

Y
o

20

0 £ 3 T 1 T 4 T ] 1
1854 1856 1858 1860 1862 1864 1866 1BeB 1370 1872

Year

To print

14. Click and drag your chart up to Row 2, Column C. Siretch it out into Column L
and down into Row 19.

15. Highlight Column C to Column L, from Row 1 1o 20.

16. Using the Page Layout tab, choose Print Area and Set Print Area.

17. Click on the Home button at the top left, Choose Print.

13



Lake Mendota Ice Cover Data Since 1852

hitpsy//Her.Jimnology. wisc.edu/about/lakes/mendota ice cover

Start Year End Year Ice-On Date Ice-Off Date Ice Duration

1855 1856  1855-12-18 1856-04-14 118

1856 1857  1856-12-06 1857-05-06 151

1857 1858  1857-11-25 1858-03-26 121

1858 1859  1858-12-08 1859-03-14 96

1859 1860  1859-12-07 1860-03-26 110

1860 1861  1860-12-14 1861-04-10 117

1861 1862  1861-12-02 1862-04-13 132

1862 1863 1862-12-26 1863-04-09 104

1863 1864  1863-12-18 1864-04-21 125

1864 1865  1864-12-08 1865-04-05 118

1865 1866  1865-12-14 1866-04-18 125 /

1866 1867 - 1866-12-18 1867-04-20 123

1867 1868  1867-12-12 1868-03-31 110

1868 1860  1868-12-10 1869-04-16 127 .5

1869 1870  1869-12-02 1870-04-12 131 \

1870 1871  1870-12-24 1871-04-02 99 /ﬂ‘“\g OQ 25
1871 1872 1871-12-19 1872-04-23 126 Y ﬂﬁ
1872 1873 1872-11-30 1873-04-23 144 2] y \?

1873 1874  1873-11-29 1874-04-14 136 W Q -
1874 1875  1874-12-10 1875-04-15 126 0

1875 1876  1876-01-10 1876-04-10 91 _X(& .
1876 1877  1876-12-08 1877-04-17 130 X0 H{W (V
1877 1878  1878-01-06 1878-03-09 62 0 v~ l}/)Q
1878 1879  1878-12-21 1879-04-12 112 05 \;\Y{"QV(\ X
1879 1880  1879-12-17 1880-03-25 99 ﬂ/%
1880 1881  1880-11-23 1881-05-03 161 DU

1881 1882 1882-01-02 1882-03-21 78 J(‘(\}’

1882 1883 1882-12-10 1883-04-13 124

1883 1884  1883-12-18 1884-04-15 119
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Student Activity
Dancing Molecules

To illustrate absorption of energy by molecules that are greenhouse gases, you will be

comparing the range of movement of the various molecules. “Construct models of the molecyles
in the chart below by using pipe cleaners and sytrofoam or other materials as directed by your
teacher. Each straight line on the molecule diagrams represents a chemical bond. Create the
hand by curling a pips cleaner around a pencil or pen. After you have construted the molecutes,

rark their relative movement as you hold them and move them around. Complete the chart by
reading the Gresnhouse Gases handout, ' '

B 'i_Relati've__' Cagthisa ] 'At.mQSphéric - Global Warming
-\ Movement . house gas? | Concentration,  Potential (100 Yr)
: | | %byvolume

GO

Oxygen

.| €Carbon Dioxide

OO

Methane

20,0}

Nitrous Oxide

1. Which molecules moved the most?

Which molecules moved the least?

Which molecules are greenhouse gases?

CONET

Refer to the Greenhouse Gases reading and compiste the columns in the table above,
Other than water vapor, which greenhouse gas is the most abundant?

8. Which of the greenhouse gases in the chart above has the greatest Global Warming
Potential but is the least abudundant in the atmosphera?

1/9/2012 - .
Crented by Dr. Jaret Voul

(v enck V'L'LLULL( Stocke LLniversity
| i tasun



Gases that trap heat in the atmosphere are ofien
called greenhouse gases. Some greenhouse
gases such as carbon dioxide occur nafurally
and are emitted to the atmosphere through
natural processes and human activities. _
Water vapor is a greenhouse gas that has a
variable composition in the: atmosphere, Other
greenhouse gases (e.g., fiuorinated gases)
are created and emitted solely through human
activities. The Global Warming Potential
(GWP) value is used to compare the abilities

_ of different greenhouse gases to trap heat in

the aimosphere. GWPs are based on the heat-
absorbing ability of each gas relative to that of
carbon dioxide (CO,), as wall.as the atmospheric
lifetime of the gas {the amount removed from the
atmosphere over a given number of years)

The principal greenhouse gases thaf enter the

atmosphere because of huian activities:are:

* Carbon Dioxide (CO,): Carbon dioxide-
enters the atmosphere through the burning
of fossil fuels (ofl, natural gas, and coal),
solid waste, trees and wood products, and
also as a result of other chemical reactions
(s.g9., manufacture of coment). Carbon
dioxide is aiso removed from the atmosphere
(or “sequestered”) when it is absorbed by

plants as part of the blological carbon cycle.
GWP =1

* Methane (CH,): Methane is emitted during

the production and transport of coal, natural
gas, and oil. Methane emissions also

resuit from livestock and other agricultural
practices and by the decay of organic waste
in municipal solid wasie landfills. GWP =25

» Nitrous Oxide (N,O): Nitrous oxide is

emitted during agricultural and industiial
activities, as well as during combustion of
fossil fuels and solid waste. GWP-= 298

° Halocarbons: Hydrofluorocarbons,

perfluorocarbons, and sulfur hexafiuoride

are synthefic, powerful greenhouse gases
that are emitted from a variety of industrial
progesses. Fluorinated gases are sometimes
used as substitutes for ozone-depleting

. ~Rioim Gt -

f st et

Sourze: htpiveww.est noas.govigsdioutreachiaducation/climgraphy

substances (i.e., CFCs, HCFCs, and halons).
These gases are typically emitted in small
quaniities, buf because they are potent
greenhouse gases, they are sometimes
referred to as High Global Warming Potential
gases (“High GWP gases™). GWP = 1,430 -
22,800,

Graenhouse Gas Inventories
A greenhouse gas inventory is an accounting of
the amount of greenhouse gases emitted fo or
removed from the atmosphere over a spacific
period of ime (e:g., one year). A greenhause
gas inventory also provides information on the
acfivities that cause-emissions and removals, as
welt-as background on the methods used fo make
the calculations. Policy makers use greenhouse
gas inventories o track emission trends, develop
straitegies aind policies and assess progress.
Scientists use greenhouse gas inventories as
inputs to atmosphetic and economic models.
Michigan (and many other staies) has developed
a greenhouse gas inventory.

Sourees;
hitp:/fepa.goviclimatechange/emissione/index,

him} Michigan Greenhouse Gas Inventory http:/fnaany.
michigan.gov/documentsideq/Mil_Greenbhouse Gas_
Inv_1990_2002 277467 7.pdf
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The Carbon Cycle

DATA RECORD SHEET

Record the places you have traveled as a carbon molecule before human interference,
You may or may not fill up all the spaces.

Student's Mame:

BEFORE HUMAN INTERFERENCE

Station Stop What Happens Destination
1.
2.
3.
4,
5.
6.

AFTER HUMAN INTERFERENCE

Station Stop What Happens Destination

10.

(Adapted by Jennifer Ceven, Grade 6 Science Teacher, from “The Incredible .j.lourney." Project Wel)



Name:
Hour:

The Carbon in Trees

By Christine Gaerer, Grossa Pointa Schools
Adaptad from Carbon In Trees by K. Schmitt, Michigan Technelogical University, 2014

You are going to calculate an estimate of how much carbon is stored in trees around the
school.

First, choose a tree that you can easily measure diameter at about 4.5 fest above the
ground (standard measurement for forestry).

1. Find the diameter of your free:

Using the Diameter Tape, find the diameter of your tree in centimeters at about 4.5 feet
above the ground. (The Diameter Tape has already helped you calculate c = * d.)

Diameter of your tree (d):

in. x 2.54= cm

————————

2. Identify your tree.

Use the pictures below, the handout, or ask Mrs. Geerer.

Color and draw the leaf veins of these common jrees.
Thzn use them Te idenilfy frees the near you!

<5 Bu:mud Md‘m)
J-wru frod) s (S i S

e et
A otk
"“m m‘kgmdmu!n
\ sm(mw
S
-h..,«"f
L ok (hie) Gk {Ra T #
‘ mmwnahm } N
A :
t_-.:\ - 3
. .. X ¥
(h = i :
L . \'\ / —
e oy e
L Sycama
N yeanere (neriem)
Basch fansziesn) “““"Ws,f,‘;“"""’ f,f P ttbeniire
/ -
7
‘1 [ 7
\ J' ;) f'/
i

TRA"kS guides are generated bﬂ:mm s\:ranhsts {ke youl For mare Informaiion,
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3. Find the biomass for your whole tree:

The formula is a 6°x a = biomass (kg)

Find your “a” number on the chart below:

Tree Specles
American Elm (.08
Aspen or Cottonwood 0.05
Ash .16
Basswood 0.09
Beach 0.2
Dopwood 0,05
Cherry Tree 0.16
Hickory 0.08
Northern White Cedar 0.09
Red or Silver Maple 0.16
Red Qak 0.13
Red Pine 0.17
Sugar or Norway Maple 0.7
Tulip Tree 0.06
White birch 0.12
White pine 0.75
Willow 0.16

Calculate. Don't forget to “square” your diameter.

diameter

biomass (kg)

T/



4. Find the total carbon cohtent for your tree:

+ 2 =
biomass(kg) kg of carbon

5. Convert the amount of carbon from kilograms to pounds:

X 22 =
kg of carbon Ib of carbon

6. Convert carbon to carbon dioxide (CO’):

X 3.67 =
Ib of carbon Ib of CO?

My tree contains pounds of CO*

Now solve the problem:

A car emits 19.6 lbs of CO? for each gallon of gas. |f you use 400 galions
of gas a year, how much CO?would you emit?




Names:
Hour:

Carbon Cycie Poster

Christine Geerer, Grosse Polnte Schools

{50 points)

You will work with one or two partners to create a mode! describing the function of the
carbon cycle and identify three things you could do to reduce atmospheric carbon.

Your poster must include:

a. A diagram or graphic of the carbon cycle that labels sources and sinks and how
they interact. You should identify each source as natural or man-made.

b. A description of three ways you, as students, could reduce carbon sources or
increase carbon sinks.

Requirement 2 points 6 points 8 points 10 points
Carbon cycle 1 or fewer sinks | 2-3 sinks 4 sinks identified | 5 or more sinks
sinks identified identified identified
Carbon cycle 1 or fewer 2-3 sources 4 sources 5 or more
sSources sources identified identified sources
identified identified and
labeled man-
made or natural
Carbon cycle Most of the Graphics are Graphics are Graphics are
graphic design graphic is somewhat ciear, | mostly clear, clear, correct,
includes incorrect or correct. Some correct, and and include
identifying the missing. interactions include some many
interaction of the iabeled. Few illustrations. ilustrations.
sources and illustrations. Interactions are | Interactions are
sinks. labeled. labeled with
detail.
Ways io All suggestions One way to Two ways to Three or more
decrease carbon | are incorrect. increase sinks or | increase sinks or | ways 10 increase
sources or decrease decrease sinks or
increase sinks sources is sources are decrsase
are listed and correct and correct and sources are
labeled as labeled. labeled. correct and
“source” or labeled.
(isink”.
Overall product | Little effort or Some evidence | Mostly neat, Neat, colorful,
guality creativity of effort and creative, and creative, shows
evident, -creativity. colorful, shows best effort.

gffort.

21



Name ‘ Period

Unit 8.5: Global Climate Change Final Project

You are a research scientist and desire to apply for a grant to fund further research concerning
the impact of climate change in your state. Your challenge is to find good scientific evidence on
your topic and develop a testable question. After evaluating this evidence you will develop a
hypothesis for your grant request.

Requirements:

1) You will decide on a testable question. Example: Does climate change benefit agriculture in
Michigan? {You are asking a question if climate change benefits or harms an environment or
industry in Michigan.) Use www.goscienceseven.com/SeiMethod/sciquestions.html as a
reference for writing your question.

Research question;

2) Find and evaluate three reputable sources (see the rubric for more details) that will help
provide evidence to answer your research question.

3) Use the C.A.R.S Checklist for Evaluating Sources
hitp://wwwiteracyta.com/sites/default themes/literacvia/websiteevalchecklist. pdf)

4) If your research guestion needs to be modified re-write it here:

5) Once you have identified three reputablé sources, complete the CER {Claim, Evidence
Reasoning) Sheet for each article (attached).

6) Cite your three sources. Make sure to include the citation on the CER! (www.easybib.com)
7) You will do this part last!!!

Once you have evaluated the evidence in your articles, develop a hypothesis. Thisis a
staternent about what you believe based on your research. Use the format: if....then...because...



Example: If global climate change increases, then the jellyfish population will increase
because...(here is where you would explain your evidence). '

Your hypothesis:

7%



Use the rubric below to ensure you have all components of this project:

Sample Rubrlc:

Points

2

5 4 3 1
Testable Question is clear | Questionisclear | Ouestionisclear | Questionis Question is
Question and testable and testable but | but not testable unclear and not neither ciear nor
nat directly testable testable
related to dimate
change
Supporting 3 pieces of 3 pieces of 2 pieces of 2 pieces of 1 piece of
Evidence evidence fromat | evidencefrom1 | evidencefromat | evidencefroml | evidence
|east 2 different type of source least 2 different type of sources
(types of sources: | types of sources types of sources
books
magazines
internet
videos
pod casts
tv documentary
newscasts
interviews)
Rationale for Complete Complete Partial Partial incomplete
further explanation axplanation explanation with | explanationt with | explanation with
investigation {includes data} {includes data) suppart from 4- | support from less | minimal support
on why this on why this 5 sources than 3 sources
should be shauld ke
investigated investigated with
including support | support from less
from 5 sources than 5 sources
Hypothesis Clear, Concise Clear, concise Clear and concise | Whittenasa Not testable and
and testable and testablebut | but not easily guastion, but not clear
writtenas a testable clear and
guestion " conclse, not
easily testable
' Source Citations | 3 reputable 2 reputable 1 reputable
{if asourceisnot | cltations properly citations propertly citation properly
reputable it done done done
doesn’t count}

el



Created by Christine Geerer, Grosse Pointe Public Schools
MName:

Hour:

Wind Turbine Engineering Journal
(20 points)

Record your work on this document as you design your wind turbjne.

1. Define the problem:

2. What are the limits you have to work with?

3. Sketch your first design. Label the parts of the diagram.

4. Build your design,.

L Find



5. Using one full breath blowing through a siraw, test your turbine by timing how
long it turns. Repeat three times and find the mean.

Time (s}

Trial One Trial Two Trial Three Mean

8. Note any uncontrolied variables here:

7. Note any construction problems:

8. What improvements could you make on your next wind turbine iteration?
Wirite/sketch below plans for your second turbine design. Label the parts of your

diagram.



9.  Build your second design.

10. Using one full breath blowing through a straw, test your turbine by timing how

long it turns, Repeat three times and find the mean.

Time (s)

Trial One

Trial Two

Trial Three

Mean

11.Note any uncontrolled variables here:

12. Note any construction problems:

13. What improvements could you make on your next wind turbine iteration?
Write/sketch below plans for your third wind turbine design. Label the parts of

your diagram.
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14. Build your third design.

15.Using one full breath blowing through a straw, test your turbine by timing how

long it turns. Repeat three times and find the mean.

Time (8)

Trial One

Triai Two

Trial Three

Mean

16.Note any unconirolled variables here:

17. Note any construction problems:

18. Which turbine design worked the best?

19. Why do you think that design worked best?

yA)



20. Write a paragraph to a wind turbine engineer, describing what you learned abdut
building wind turbines, to help him/her design them better:

Wind Turbine Journal Rubtic

(20 points)
0 points 3 points 4 poinis 5 points
Completion Most questions Some. No more t'han All guestions
are left blank questions are two questions have responses
left blank are left blank P
Most Some Most ;
Calculatiohs calculations are | calculations are | calculations are '::Iet::;? elztlons
incorrect correct correct
. Some diagrams | Most diagrams | All diagrams
Diagrams are
Diagrams unclear: lack are clear and ﬁre clear and la:re: clear and
labels/units ave . ave . ave .
labels/units labels/units labels/units
Some Thought and
Thought and I;/Ir:sgrnggzréses responses are I;ﬂh%ﬁ ';ii%oﬁes effort are
effort naloar brief and and effort g evident in all
unclear responses
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